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I.	GENERAL	INTRODUCTION	TO	MARCEDIT		
	
MarcEdit	is	a	software	product	that	can	be	used	to	edit	MARC	records.		It	was	developed	by	
Terry	Reese,	head	of	Digital	Initiatives	at	the	Ohio	State	University	Libraries.		It	is	available	to	all	
libraries	as	a	free	download	at	Terry	Reese’s	website.	While	you	can	use	MarcEdit	to	edit	
records	one	at	a	time	like	the	Voyager	cataloging	client,	it	is	its	ability	to	perform	the	same	
change	or	many	different	changes	within	groups	of	records	that	makes	it	such	a	useful	tool.	This	
ability	to	do	batch	processes	means	that	catalogers	have	a	powerful	and	time-saving	tool	to	use	
to	enhance	our	catalog	records.	
	
MarcEdit	is	a	suite	of	tools,	not	all	of	which	are	needed	for	performing	basic	editing	tasks.	
MarcEditor	is	the	primary	tool	you	will	need	to	edit	bibliographic	records.	MARC	Tools	is	
primarily	for	converting	to	and	from	different	metadata	formats.		
	
The	terminology	that	MarcEdit	uses	may	be	obscure	to	some	librarians.		A	machine-readable	or	
"raw"	MARC	record	is	not	like	the	human-	or	eye-readable	MARC	records	that	we	are	used	to	
seeing	in	the	OCLC	Connexion	Client	or	in	the	Voyager	cataloging	client.	A	"raw"	MARC	record	
looks	like	this:	
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			Image	of	a	raw	MARC	record	
	
While	some	parts	of	record	in	this	format	are	readable	by	the	human	eye,	others	are	not.		In	
order	for	a	person	to	read	and	edit	the	MARC	record,	it	must	be	“broken.”		A	“broken”	MARC	
record	thus	looks	like	something	much	more	familiar:	
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   Image	of	a	Broken	MARC	Record	
 
MARC	records	as	they	appear	in	the	Voyager	cataloging	client	and	in	the	OCLC	Connexion	Client	
are	already	displayed	in	the	“broken”	form,	even	though	that	terminology	is	not	used	there.			
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The	primary	editing	functions	are	in	the	MarcEditor	tool.	MarcEditor	has	word	processor-like	
find	and	replace	functions	in	a	couple	of	varieties.	There	is	a	universal	find	and	replace,	which	
will	perform	the	changes	on	a	text	string	that	it	finds	anywhere	in	the	file.	There	also	are	“Edit	
field”	and	“Edit	subfield”	tools;	these	will	find	and	replace	text	just	like	the	universal	find	and	
replace	does,	but	can	be	limited	to	particular	MARC	fields	or	subfields	as	needed.			
	
Yet	another	way	of	editing	records	is	by	using	regular	expressions,	sometimes	shortened	to	
“regex.”	A	regular	expression	is	a	special	text	string	for	describing	a	search	pattern.	Those	with	
some	experience	with	computer	programming	languages	may	have	some	knowledge	of	regex.	
Otherwise,	consult	with	CARLI	staff	or	the	larger	MarcEdit	user	community	for	help	in	devising	a	
regular	expression	that	will	meet	your	needs.		
	
It	is	important	to	remember	that	the	MarcEdit	tools	described	here	can	only	copy	your	MARC	
records	and	manipulate	those	copies.	The	corresponding	records	in	your	library’s	database	will	
not	change	until	you	submit	the	records	you	have	edited	to	CARLI	for	uploading	and	replacing.	
This	is	a	handy	feature,	because	it	allows	a	cataloger	to	edit	and	then	check	the	results	of	the	
edit	to	ensure	there	were	no	unintended	consequences.	In	other	words,	you	could	do	a	lot	of	
damage	to	your	records	in	an	attempt	to	edit	them,	but	nothing	really	happens	to	them	in	
Voyager	until	you	are	sure	the	edits	made	are	what	you	intended	and	you	submit	them	to	CARLI	
for	uploading.	CARLI	staff	acknowledge	this	danger	in	the	warning	that	appears	in	the	MarcEdit	
section	of	the	Voyager	Clients	and	Tools	web	page:	
	
“IMPORTANT	NOTE:	Any	errors	made	to	bibliographic,	holdings,	or	authority	records	using	
any	of	MarcEdit	are	the	responsibility	of	the	library	to	correct	locally.	The	CARLI	Office	will	
NOT	restore	any	database	because	of	errors	made	to	records	by	imprudent	or	incorrect	use	of	
this	tool.	By	installing	and	running	MarcEdit,	the	library	accepts	this	policy.”	
	

A	Typical	Workflow	for	Editing	a	Group	of	Records	in	MarcEdit	

1. Identify	and	gather	records	that	need	to	be	edited.			
(See	Part	II	below,	“Ways	to	Identify/Gather	Records.”)	

2. Since	the	records	you	get	will	be	“raw”	MARC	records	(.mrc	files),		
use	MarcBreaker	to	“break”	them	into	an	editable	form	(.mrk	files).	

3. Use	the	various	editing	tools	in	MarcEditor	to	make	the	desired	changes	to	your	records.	
4. Save	the	file	in	MarcEditor.	
5. Convert	the	“broken”	records	back	into	regular	MARC	records		

(i.e.,	convert	from	.mrk	to	.mrc)	using	MarcMaker.	
Steps	6-8	pertain	to	I-Share	libraries	only	

6. File	a	Work	Request	Online	(WRO,	pronounced	roe)	requesting	that	CARLI	staff	replace	
the	MARC	records	in	Voyager	with	the	corresponding	(now	edited)	records	in	the	file.	

7. Transfer	the	edited	MARC	records	file	to	CARLI’s	FTP	site	so	that	CARLI	staff	can	access	it.	
8. CARLI	staff	will	upload	and	replace	the	records,	and	will	notify	you	when	that	has	

happened.	
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II.	WAYS	TO	IDENTIFY/GATHER	RECORDS		
	
A.	For	I-Share	Members:	Extract	Records	from	Voyager	Using	Access	Reports	and	WROs	
	

Step	1.	Identify	the	records	using	Access	reports	
In	Access,	you	will	find	a	list	of	queries	in	the	left-hand	column.	Some	are	“prepackaged”	by	
Ex	Libris,	but	if	you	have	linked	the	CARLI_Reports_2015.mdb	file,	you	will	also	have	access	
to	queries	written	by	CARLI	staff	and	I-Share	colleagues.	You	may	or	may	not	find	a	query	
that	describes	the	set	of	records	you	wish	to	edit.		

a. If	you	find	a	query	that	matches	what	you	want,	double-click	on	it.	The	results	
appear	on	the	right	and	will	include	a	list	of	records	by	ID	number	(Bib	ID	or	MFHD	
ID).	Export	the	results	and	open	them	in	Excel	to	examine	and/or	manipulate	the	list.	
(For	further	details	about	using	Access,	view	CARLI’s	Access	training	videos.)		

b. If	no	pre-existing	query	listed	in	Access	exactly	describes	what	you	need,	file	a	
WRO	to	ask	CARLI	staff	to	write	a	query	according	to	your	specifications.		

• Under	Work	Request	Type,	choose	Ad	Hoc	(Customized)	Report.		
• Under	Notes,	describe	your	desired	record	set.		

Examples:	
- Find	bib	records	where	100	$d,	600	$d,	or	700	$d	contains	<ca.>	
- Find	bib	records	where	130	$a	or	630	$a	is	<Koran>	

CARLI	staff	will	then	construct	a	custom-made	query	for	you	and	notify	you	when	
the	query	results	are	ready.	Those	results	will	be	delivered	either	through	email	or	
to	your	I-Share	library’s	FTP	site	as	an	.xls,	.xlsx.,	.xml,	.txt,	or	.csv	document.		

Step	2:	File	a	WRO	for	CARLI	to	extract	the	records	
To	request	a	file	of	your	designated	records	from	CARLI,	submit	a	WRO.		

• Under	Work	Request	Type,	choose	Other.		
• Note	that	the	way	CARLI	extracts	records	from	the	catalog	database	is	via	record	IDs.	

So,	to	designate	which	records	you	want,	copy	the	record	IDs	into	a	.txt	document	
(Notepad)	and	upload	it	to	your	library’s	I-Share	FTP	site.		
For	further	details	about	using	WROs,	see	http://www.carli.illinois.edu/using-work-
requests-online.	

Step	3:	Retrieve	your	records	
CARLI	notifies	you	when	your	file	is	ready.	Get	it	from	your	library’s	FTP	site.	It	is	a	.mrc	file.	
Now	you	are	ready	to	import	that	file	into	MarcEdit.	
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B.	For	All	CARLI	Members:	Obtaining	Records	from	Vendors	

Sometimes	a	vendor	makes	sets	of	MARC	records	available	to	libraries	or	library	consortia.	
When	your	library	licenses	a	new	collection,	inquire!	For	example,	libraries	that	subscribe	to	
ProQuest	Dissertations	&	Theses	can	obtain	title-level	MARC	records	for	their	institution’s	
online	dissertations	and	theses.		In	all	cases,	a	library	will	need	to	obtain	availability	information	
from	the	vendor	and	follow	their	instructions.		Some	vendors,	such	as	ProQuest,	will	send	
MARC	record	sets	by	email	attachment;	others	provide	a	website	from	which	you	can	download	
the	appropriate	batch	of	MARC	records.	While	some	vendors	provide	MARC	records	free	of	
charge,	other	vendor	records	can	be	quite	costly,	and/or	come	with	restrictions	about	whether	
their	MARC	records	must	be	restricted	to	a	library’s	local	catalog,	can	be	shared	through	a	
consortial	database,	or	promoted	to	WorldCat.	Record	sets,	such	as	the	one	for	eHRAF	World	
Cultures,	are	also	available	to	OCLC	member	libraries	through	OCLC	WorldShare	Collection	
Manager.	In	all	cases,	the	quality	of	the	records	you	receive	in	batch	should	be	evaluated	
before	you	load	them	into	your	catalog.	MarcEdit	functions	can	help.		
	
III.	PROJECT	DEMONSTRATIONS	

IIIa.	REPLACING	THE	PROXY	SERVER	URL	IN	A	BATCH	OF	BIB	RECORDS	USING	MARCEDIT		

This	tutorial	begins	assuming	that	you	already	have	a	batch	of	MARC	records	saved	to	your	
computer	that	you	would	like	to	edit.	
	

1. Open	MarcEdit	and	select	MarcEditor.	
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2. In	MarcEditor,	go	to	“File”	and	select	“Open.”	
	

	
	

3. Navigate	to	the	file	that	contains	your	batch	of	MARC	records	and	select	Open.	(You	
may	need	to	select	“All	Files”	in	order	to	see	your	batch	of	records.)	
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4. Now	is	a	good	time	to	check	to	see	how	many	proxy	URL	changes	you	will	be	making	in	
your	batch	of	records.	MarcEdit	can	tell	you	how	often	your	proxy	URL	appears	in	your	
batch	by	going	to	“Edit”	and	then	selecting	“Find.”	
	

	
	

5. In	the	Find	pop-up	window,	paste	in	your	proxy	URL	in	the	“Find	what:”	box	and	then	
select	“Find	all.”	
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6. The	“Find	all	results”	will	then	outline	the	total	number	of	times	the	proxy	was	found	
and	a	more	detailed	list	of	its	location.	In	this	example,	you	can	see	that	you	will	be	
editing	85	instances	of	the	URL	proxy.	
	

	
	

7. Now	that	you	have	your	batch	of	records	open	in	MarcEdit,	identify	the	proxy	URL	that	
you	would	like	to	change	and	the	new	proxy.	In	this	case:	

a. Old	proxy:	http://proxy.library.siue.edu:2048/login?qurl=	
b. New	proxy:	http://proxy.library.awesome.edu:2016/login?qurl=	

	
	 	



9 
 

8. Go	to	“Tools”	and	select	“Edit	Field	Data.”	
	

	
	

9. In	the	Edit	Field	Data	pop-up	box,	select	the	856	in	the	“Field”	option.	Then	copy	and	
paste	your	old	proxy	into	“Find”	and	the	new	proxy	into	“Replace.”	
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10. Select	“Process”.	A	pop-up	window	will	appear,	indicating	the	number	of	modifications	
that	have	been	made.	You	can	compare	this	number	with	the	number	of	records	
generated	in	step	6	as	a	double	check.	
	

	
	

11. Once	you	have	looked	over	and	are	satisfied	with	your	edited	records,	go	to	“File”	and	
click	“Save	as”	and	name	your	new	batch	of	records.	In	this	case,	it	will	be	named	
“CredoBatch1”.	If	you	will	notice,	the	edited	MARC	file	is	in	the	“Save	as	type”	which	is	a	
MARC	Text	File	(.mrk).	In	order	to	add	this	batch	of	records	into	the	catalog,	they	need	
to	be	converted	back	to	the	.mrc	format.	Luckily,	MarcEdit	does	this	quickly	and	easily.	
	

	
	

12. Once	you	have	saved	your	edited	batch	of	records,	close	out	of	the	MarcEditor.	You	will	
now	be	at	the	main	menu.	Select	“MARC	Tools.”	
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13. In	the	MARC	Tools	Menu,	select	the	“MarcMaker”	option.	
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14. For	the	“Input	File”	select	the	file	icon	to	the	right	of	the	text	box.	
	

	
	

15. Select	your	edited	batch	of	records	and	click	“Open”.	In	this	case,	that	is	the	
“CredoBatch1”	created	in	step	11.	
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16. Next,	select	the	file	icon	next	to	the	“Output	File.”	In	this	step,	you	need	to	name	your	
new	file.	If	you	notice	in	this	save	file	pop-up	window,	the	“Save	as	type”	is	the	MARC	
files	(.mrc),	which	is	the	format	needed	to	load	records	into	Voyager.	Once	you	have	
named	your	new	file	and	selected	its	location,	click	“Save.”	
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17. Now	you	are	ready	to	convert	your	batch	of	files	to	the	MARC	Files	(.mrc)	format.	Click	
“Execute”.	Once	you	have	done	this,	the	“Results”	text	box	at	the	bottom	of	the	page	
will	show	the	number	of	records	processed.	
	

	
	

18. You	should	then	be	able	to	find	your	saved	batch	of	edited	MARC	files	(.mrc)	records	to	
be	loaded	into	your	catalog.	

	

Part	IIIb.	USING	MARCEDIT	TO	MAKE	AN	RDA-MANDATED	CHANGE	TO	AN	AUTHORIZED	
ACCESS	POINT		

This	search	will	correct	a	change	that	was	mandated	by	RDA:	changing	“ca.”	to	“approximately”	
in	an	authorized	access	point.		If	you	know	of	a	specific	access	point	that	needs	to	be	changed,	
you	could	edit	all	instances	of	it	directly,	one	by	one,	in	the	cataloging	client;	or	you	could	use	
the	“Batch	correction	request”	feature	of	Gary	Strawn’s	Cataloger’s	Toolkit.	

However,	you	most	likely	do	not	know	which	access	points	need	to	be	changed.		A	way	to	find	
and	edit	all	the	access	points	in	one	operation	is	to	submit	an	Ad	Hoc	WRO	to	CARLI	requesting	
all	records	with	100,	600,	and	700	MARC	fields	that	contain	“ca.”	in	$d.		When	you	receive	a	file	
of	these	records,	you	can	then	use	the	MARC	Editor	function	to	find	all	instances	of	“ca.”	and	
convert	them	to	“approximately.”	
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1. Retrieve	the	MARC	files	from	the	CARLI	ftp	server,	and	copy	them	at	a	location	where	
you	can	find	them.		Open	MarcEdit	and	select	Marc	Tools.		Under	“Input	File”	find	the	
file	of	MARC	records	from	CARLI.		Make	sure	the	file	suffix	is	“.mrc.”		This	indicates	it	is	a	
standard	MARC	file.		Under	“Output	File”	copy	over	the	file	name	and	make	sure	the	file	
suffix	is	“.mrk.”		This	indicates	a	“broken”	MARC	file	that	you	can	read.		Make	sure	
“MarcBreaker”	is	highlighted,	then	click	“Execute”	to	create	the	broken	file.	
	

	

Alternately,	you	can	double	click	on	the	file	of	MARC	records,	and	MarcEdit	will	bring	up	
the	MARC	Tools	window	with	the	file	names	already	filled	in.		Then	click	“Execute.”	

2. Next,	you	need	to	open	the	broken	file	in	the	MarcEditor.		To	do	this,	select	
“MarcEditor”	from	the	main	menu,	choose	File	>	Open	or	Ctrl-O,	then	find	and	open	the	
broken	file.		
	
It	is	helpful	before	editing	to	scan	the	contents	of	the	file	for	instances	of	the	text	you	
want	to	change.		To	do	this,	choose	Edit	>	Find	or	Ctrl-F,	enter	the	text	to	search,	then	
choose	“Find	all”:	
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In	this	example,	in	addition	to	dates	such	as	“ca.	1535-1582”	there	are	also	such	dates	
as	“b.	ca.	1777.”	To	avoid	inadvertent	replacement	errors,	we	may	want	to	directly	edit	
authorized	access	points	like	that	one	in	the	Voyager	cataloging	client,	and	then	have	
CARLI	re-do	the	search.	

	

3. Once	you	are	sure	that	a	direct	replacement	of	your	text	will	work	correctly,	make	the	
change	by	using	the	“Edit	Subfield	Data”	function:	Tools	>	Edit	Subfield	Data	or	<F9>.		
Enter	the	data	to	be	changed	in	“Field	Data”	and	the	replacement	text	in	“Replace	with”	
and	choose	“Replace	text.”	
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If	you	want	to	replace	a	more	complex	pattern,	and	if	you	can	get	help	in	devising	a	
regular	expression	for	your	replacement,	enter	those	regexes	in	the	two	boxes,	and	
check	the	box	by	“Use	regular	expressions.”		In	this	example,	you	will	need	to	repeat	this	
process	for	fields	100	and	600.		

It	is	important	to	analyze	where	in	a	field	or	subfield	the	data	you	want	to	replace	will	
appear.		In	this	case,	“ca.”	is	meaningful	only	in	dates,	so	we	can	limit	the	replacement	
to	$d.		If	the	text	you	want	to	replace	could	appear	in	more	subfields,	you	may	want	to	
choose	the	“Edit	Field	Data”	function:	

	

This	will	replace	the	specified	data	in	any	part	of	the	field.		In	this	example,	replacing	
“ca.”	with	“approximately”	anywhere	in	a	700	field	would	likely	cause	errors;	for	
instance,	the	authorized	access	point	“Smith,	Monica.”	would	be	changed	to	“Smith,	
Moniapproximately.”		Limiting	the	edit	to	the	appropriate	subfield	will	avoid	errors	such	
as	these.	
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4. You	can	“Find	all”	again	and	look	to	see	if	the	replacements	you	made	are	correct.		If	
you	find	errors,	you	can	always	close	the	files	and	not	save	the	changes,	and	devise	a	
different	search	and	replacement	strategy.	
	

5. When	you	are	sure	that	the	replacements	you	made	are	what	you	want,	save	the	.mrk	
file:	File-->Save,	or	Ctrl-S.		
	

6. The	next	step	is	to	convert	the	edited	broken	file	back	into	a	regular	MARC	file.		Open	
MarcEdit	and	select	Marc	Tools.		Under	“Input	File”	find	the	broken	file	you	edited.		
Make	sure	the	file	suffix	is	“.mrk.”		Under	“Output	File”	copy	over	the	file	name	and	
make	sure	the	file	suffix	is	“.mrc.”		Make	sure	“MarcMaker”	is	highlighted,	then	choose	
“Execute”	to	create	the	regular	MARC	file.		

	

It	is	a	good	practice	to	rename	the	new	.mrc	file,	in	order	to	avoid	confusion	about	the	
status	of	the	contents.	

7. The	last	step	is	to	submit	the	edited	.mrc	file	to	CARLI.		Usually	you	need	to	place	it	the	
CARLI	ftp	server,	and	notify	CARLI	support	that	the	edited	file	is	ready	to	be	loaded.	
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IV.	PROJECTS	WELL-SUITED	FOR	MARCEDIT	
	

1. Adding	a	new	MARC	field	to	a	batch	of	bibliographic	records,	such	as	a	locally-relevant	
title	added	entry,	local	subject,	or	bibliography	note:	

a. 740		0\$a	Department	of	Special	Education	test	kits.	$5	INS	
b. 690		\\$a	Illinois	State	University	$v	Department	of	Special	Education	test	kits.	
c. 590		\\$a	Nacke-Savoie	Collection.	
d. 504		\\$a	Includes	bibliographical	references	and	abstract.	 	

	
2. Adding	a	new	subfield	to	a	batch	of	bibliographic	records,	such	as	a	public	note	about	

location	or	access:	
a. 856	40	$3	Taylor	&	Francis	Online	$u	

http://libproxy.lib.ilstu.edu/login?url=http://www.tandfonline.com/loi/wccq20	
$z	Available	on	ISU	campus	or	via	ISU	ULID	
	

3. 	Replacing	a	text	string	in	a	portion	of	a	subfield	with	another	text	string	in	the	same	
subfield	

a. For	example,	replace	your	institution’s	former	proxy	string	with	its	current	one	
within	the	856	$u	
	

4. 	Replacing	the	text	in	one	subfield	with	new	text	
a. For	example	replace	700	$e	“advisor”	in	ProQuest	MARC	records	for	

dissertations	and	theses	with	the	the	RDA	relator	term	“degree	supervisor”	
	

5. Copying	the	text	in	one	field	(710)	to	another	field	(690)	
	

6. 	Building	a	new	field	from	one	or	more	other	existing	fields,	for	example	build	a	URL	by	
adding	the	content	of	the	001	field	to	a	base	domain	name,	i.e.,	
https://mylibrary.edu/resolver/{001}		

	
7. Deleting	all	fields	with	a	particular	MARC	tag	completely	(791	in	ProQuest	MARC	records	

for	theses	or	dissertations)	
	

8. Deleting	all	fields	with	a	particular	MARC	tag	only	if	they	start	with	a	particular	character	
string,	such	as	the	field	containing	the	ProQuest	institution	code	in	records	for	theses	
and	dissertations	

a. 790	\\$a	0092		
	

9. Changing	indicator	values	for	a	particular	MARC	tag	
	

10. Applying	constant	data	
	

11. Record	deduplication	
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12. Validating	authorized	access	points	(1xx/7xx	or	6xx).	This	function	searches	a	batch	of	
records	for	unauthorized	access	points	and	suggests	the	authorized	alternative.	(See	
http://blog.reeset.net/archives/1775.)	

	
13. The	RDA	Helper	feature	(available	from	MarcEdit	>	Tools	or	MarcEditor	>	Tools)	also	

supports	the	expansion	of	abbreviations,	offering	a	list	from	which	you	can	select	any	or	
all;	the	addition	of	the	336,	337,	and	338	fields;	among	others.	

	

Part	V.		FURTHER	READING	AND	STUDY		

Web	Resources	

The	following	are	helpful	resources	for	learning	more	about	using	MarcEdit:	

MarcEdit	Development	-	http://marcedit.reeset.net/	

A	good	place	to	get	started.	Includes	MarcEdit	software	downloads,	recent	posts	from	
Terry’s	Worklog,	technical	information,	webinars,	and	other	instructive	information.	
	

MarcEdit	LibGuide	(University	of	Illinois)	-	http://guides.library.illinois.edu/MarcEdit	

Detailed	user	guide	for	MarcEdit,	including	screenshots	and	information	about	some	of	
the	non-MARC	features	of	MarcEdit,	including	the	OAI	harvester	and	linked	data	tool.	
	

MarcEdit	Listserv	-	https://listserv.gmu.edu/cgi-bin/wa?A0=marcedit-l	

Sign	up	to	join	this	discussion	list	for	users	of	MarcEdit,	which	is	great	for	getting	
project-specific	advice	and	learning	about	how	others	are	using	MarcEdit.	Terry	Reese	is	
a	regular	contributor.	
	

MarcEdit	resources	(CARLI)	-	https://www.carli.illinois.edu/products-services/i-
share/cat/secure/marcedit-resources	

A	collection	of	MarcEdit	resources	on	CARLI’s	website.	Includes	a	five-part	webinar	
series	given	by	Terry	Reese	for	CARLI	in	2015	and	materials	from	other	MarcEdit	
programs	and	workshops.	
	

MarcEdit	YouTube	channel	-	
https://www.youtube.com/playlist?list=PLrHRsJ91nVFScJLS91SWR5awtFfpewMWg	

Video	demonstrations	from	Terry	Reese	of	the	various	features	and	functions	of	
MarcEdit.	The	next	best	thing	to	hands-on	learning	when	you’re	not	quite	sure	how	to	
get	started.	
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RegExr	-	http://regexr.com/	

Interactive	resource	for	learning	about	and	testing	regular	expressions,	which	can	be	
used	in	MarcEdit.	
	

Terry’s	Worklog	-	http://blog.reeset.net/	

Maintained	by	Terry	Reese,	creator	of	MarcEdit.	Includes	new	regarding	MarcEdit	
updates,	explanations	of	new	or	overlooked	MarcEdit	functions,	and	lots	of	other	
helpful	discussion.	

Journals	

The	following	journals	can	be	consulted	for	articles	describing	uses	for	MarcEdit:	
• Computers	in	Libraries	
• Code4Lib	Journal	
• Journal	of	Library	Metadata	
• Library	Resources	and	Technical	Services	
• Technical	Services	Quarterly	

Other	

If	all	else	fails,	try	Google!	There	are	lots	of	helpful	presentations	and	training	documents	out	
there	to	explore.	

	


